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Troubleshooting Mail Merge 

When performing a mail merge there are many reasons why it might fail or take a long 
time to complete.  

During a Mail Merge the selected contact details are passed to Microsoft Word. Once this 
part is done the balance of the job is within Microsoft Word, and then the print driver if 
you are printing the resultant merge. Often if there is a problem it is after the initial 
Merge and so you need to look closer at the secondary applications Microsoft Word or 
the printing device. 

Caution: Performing some of the tasks listed may have a direct impact on your computer system and all 
care should be taken when performing any of these tasks. This article makes no warranty or guarantees 
that it will not damage your system or render it inoperable and you should always have backup of your 
system or select files before beginning. 

If in doubt when performing any of these tasks speak with your system administrator before proceeding or 
get them to complete the selected task. 

Top issues for resolving Mail Merge issues. 

While this may not be a complete list of possible solutions it may require more than one 
to resolve the issue on your machine. Work you way through each to better determine 
where the problem can be resolved. 

1. Reboot before you begin Mail Merge. A mail merge this process is memory 
intensive so before you begin the merge reboot your machine. This will refresh 
the memory and can often be the key to successful merges. 

2. Check on Office updates. It can be that there has been an update provided for 
Microsoft Word that correct the particular Mail Merge problem on your machine. 
To check for office updates use the following steps: 

a. Word 2003 

Step 1. Open Microsoft Word 

Step 2. Select the Hep Menu 

Step 3. Select the check for updates option. This will launch the Microsoft Office 
updates option. 

Step 4. Follow the onscreen instructions. 

Step 5. Reboot machine and retest. 

b. Word 2007 

Step 1. Select Home Menu button 

Step 2. Select Word Options 
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Step 3. Select Resources Options 

Step 4. Select Check for Updates. This will launch the Microsoft updates website.  

Step 5. Follow onscreen instructions to download any applicable updates. 

Step 6. Reboot machine when complete and retest Mail Merge. 

3. Do not send the mail merge directly to the printer. Instead send the merge to 
the Word Processor and then print the resulting document especially if the 
resultant merge is over 150 contacts in stages. Microsoft Word has been known to 
have some issues printing documents over 150 pages to some printers. 

a. When printing a document with over 150 contacts print them in separate 
print runs of say pages 1-100 and then a second run of pages 101 – 200 
etc. This will then send separate smaller jobs to the print queue. 

b. If you are printing to a network printer make sure that the spool size is 
large enough to accommodate the size of the job you want to print. An 
average document might be 2-3Mb while a mail merge a hundres of 
contacts might be 30-40Mb and some printers find this difficult to deal 
with. If in doubt speak with your system administrator. 

c. If you insert images into your merge then this can result in very large file 
sizes and you may have to reduce the print volume down even further. 

Note: This particular solution might also involve the Print driver mentioned 
later in this article. 

4. Some Characters Print Incorrectly or Do Not Print If certain characters print 
incorrectly or do not print at all, try changing the font of the characters and 
printing for a second time. 

a. To change the font, follow these steps:  

b. Using your mouse pointer, select the text or symbols.  

c. On the Format menu, click Font.  

d. Select a common TrueType font, such as Arial or Times New Roman, and 
then click OK.  

e. If the problem does not occur when you use a different font, the cause of 
the problem is probably a damaged font or a damaged printer driver. 

f. If another printer device is available, try to print with it to determine 
whether the same problem occurs. This may quickly tell you whether the 
printer driver is causing the problem. 
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g. For help with reinstalling or updating the printer driver speak with your 
local system administrator.  

h. If changing the font does not help, try this: Change the paragraph style for 
the problem text to Normal, and then remove all direct formatting from the 
selection. To do this, follow these steps:  

1. Using your mouse pointer, select the text or symbols.  

2. On the Format menu, click Style.  

3. In the Styles list, select Normal and then click Apply.  

4. With the text or symbols still selected, press 
CTRL+SPACEBAR and then press CTRL+Q to remove all 
direct character formatting and paragraph formatting, 
respectively.  

5. Try again to print the document.  

6. If the problem persists, make sure it is not specific to this 
particular document. To do this, type the same characters 
into a new document, and then print the document. 

7. If you do not see the same symptoms in a different 
document, the document file is probably damaged 
(corrupted). 

5. Clean out your temp (local temporary) folder. The temp folder on machines 
often becomes clogged with hundreds of left over files when opening and closing 
applications. It is good practice like you put oil in your car to clean this out every 
now and again. 

a. Close down all applications 

b. Restart your machine 

c. After restart Go to Start button 

d. Select the Run option 

e. Type in %temp% and click on OK 

f. Everything in the folder opened is in your temp local folder. 

g. If you delete everything from this folder it will be placed into the recycle 
bin so it could be recovered if you deleted something you not have done. 
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6. Macro Security set to high. There are times where the Macro setting in Word 
may be causing Mail Merge issues. You can test if this is the cause of your issues 
by temporarily setting the Macro settings to a lower setting. 

Step 7. Close other applications 

Step 8. Open Microsoft Word 

Step 9. Go to Tools menu 

Step 10. Select Macro option 

Step 11. Select Security option. 

Step 12. Set the option to Low. 

Step 13. Close Microsoft Word and retest merge. 

7. Damaged Print driver. This is one aspect that is often the last to detect. With the 
updates to either the Windows OS or Office updates this may then cause problems 
between the application and installed print driver. Go to the website of the 
particular printer and check if there have been any print driver updates for both 
your specific printer and operating system. 

8. Damaged Word template. At times the specific template you are using could 
become damaged and cause mail merge problems. Open the template and perform 
a Save As giving the template a new name may solve this particular issue. 

9. Damaged “Normal” template. Whenever you open Microsoft Word it uses the 
default settings contained within the “normal.dot” (Word 2003) or “normal.docx” 
(Word 2007). If you delete the normal template when you next open Microsoft 
Word a new template is created. This may resolve the problem. To delete the 
existing normal template use the following steps: 

Step 14. Close all your open Applications 

Step 15. Go to Start menu 

Step 16. Select the Run option 

Step 17. Type in the following command. %appdata% 

Step 18. Click on OK. This will open the local Application Data for the currently 
logged in user. 

Step 19. Select the Microsoft folder and open 

Step 20. Select the Templates folder and open 

Step 21. If all your applications are closed look for any files that begin with a ~ 
(tilda). This is a sign of a currently open file. If one of these files is 
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~$Normal.dot (Word 2003) or ~$Normal.dotm (Word 2007) then delete 
this file. 

Step 22. Locate either the Normal.dot (Word 2003) or Normal.dotm (Word 2007) 
in the same folder and delete these files. Open Word to make sure that it 
opens correctly and then close Word. 

Step 23. Reboot and retest the merge. 

10. Damage Microsoft word installation. Over time it could be that your installation 
of Microsoft Word may become damaged. Depending on the version of Word 
there are different methods to check and resolve if this is the problem. 

a. Word 2003 – Open Microsoft Word 

i. Go to the Help menu 

ii. Select Detect and Repair from the options 

iii. When the dialog box appears check on Start 

iv. A progress bar will display the progress of the repair. You 
may be required to insert your Microsoft Office disk during this 
process. 

v. At Completion close Word and restart machine. Retest 
Mail Merge. 

b. Word 2007 – Open Microsoft Word 

i. Go to home menu 

ii. Select Word Options 

iii. Select Resources Options 

iv. Select Run Microsoft Office Diagnostics. Click on 
diagnose button 

v. Select Continue. 

vi. Select Run diagnostics. 

vii. When diagnostics is complete reboot machine and retest 
Mail Merge option. 

11. ClassFactory errors when Mail Merging to Microsoft word. Generally this error 
occurs at the beginning of the mail merge. There are generally a couple of reasons 
that can cause this problem 
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a. Damaged Normal.dot file – The method for replacing the default template 
is described earlier in these steps. 

b. Microsoft Script Blocking. This step will require Manually Editing 
Registry Entries. We strongly recommend that you back up the Windows 
system registry prior to editing it. Incorrect changes to the registry can 
cause applications or even Windows itself to cease functioning.  

i. To correct the registry entries (after backing up the registry):  

ii. Exit any programs that are currently running.  

iii. Click the Windows Start button, and then click Run. The 
Run dialog box appears.  

iv. In the Open box, enter regedit, and then click OK. The 
Registry Editor launches.  

v. Maximize the Registry Editor so that it occupies the whole 
screen.  

vi. In the left pane, navigate to and click the following key: 

1. HKEY_CLASSES_ROOT\CLSID\{0006F03A-0000-0000-
C000-000000000046} 

2. If there is a plus sign (+) to the left of the folder, click the 
plus sign to expand it: 

3. In the left pane, look for a subfolder of the {0006F03A-
0000-0000-C000-000000000046} folder named 
InprocServer32. If it exists, right-click the InprocServer32 
folder, and then click Delete from the shortcut menu. A 
Confirm Key Delete dialog box appears:  

4. Click Yes to confirm the deletion. 

5. Exit the Registry Editor.  

6. Restart Windows.  

vii. If renaming the Normal.dot file or removing the 
InprocServer32 registry key does not resolve the issue, you may be 
able to resolve this issue by uninstalling and then reinstalling 
Microsoft Word. 

12. Problems with Antivirus software. Depending on your antivirus this may be one 
area that requires some research and testing. Consult with your antivirus provider 
as to any issues regarding integrated applications with Microsoft Word. You 
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might even test disabling your Antivirus software while testing the Mail Merge to 
see if there are any differences in the result. 

13. Reinstall Print Driver. At times if the print driver is damaged or out of date may 
require to remove and reinstall the Print driver. Consult with your printer 
documentation or manufacturer as to the steps required for this process. If this is a 
network printer you may need to speak to your administrator to perform this task. 

14. Reinstall Microsoft Office. Should all other options fail you may need to remove 
and reinstall Microsoft Office. You should consult the Microsoft website for 
details if you are unsure how to perform this step. 


